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Introduction

The Battery Design Module offers a wide range of functionality for modeling and 
simulation of batteries: from the fundamental processes in the electrodes and 
electrolytes of batteries to cell-to-cell temperature and current distributions in 
battery packs. These simulations may involve the transport of charged and neutral 
species, current conduction, fluid flow, heat transfer, and electrochemical 
reactions in porous electrodes.
You can use this module to investigate the performance of batteries at different 
operating conditions and for different electrode configurations, separators, 
current collectors and feeders, materials, and chemistry. The description of the 
involved processes and phenomena may be defined in a fairly detailed manner, 
whereby you can apply different hypotheses to gain an understanding of the 
investigated systems. With these detailed models you can study the influence of 
different electrode materials, pore distribution, electrolyte composition, and other 
fundamental parameters on various aspects such as battery performance, as well as 
capacity and power fade.
The module also allows for more lumped (“black-box”) modeling approaches 
where detailed knowledge of the battery chemistry is not required. Such lumped 
models can be used for investigating cell-to-cell dynamics in packs, thermal 
management, as well as battery dynamics in electrical circuit simulations. The small 
set of parameters used in lumped models are well suited for fitting to load-cycle 
experimental data, and parameter estimation tools, using optimization solvers, are 
also included in the Battery Design Module.
You can couple the battery models to other physics such as heat transfer, fluid 
flow, structural mechanics, and chemical species transport in order to study 
phenomena like aging, heat dissipation effects and stress-strain relationships.
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Figure 1: The 3D physics interfaces for the Battery Design Module, as shown in the Model Wizard, with 
the Electrochemistry branch fully expanded.

The figure above shows the available physics interface in the Battery Design 
Module under the Electrochemistry ( ) branch. These electrochemistry 
interfaces are based on the conservation of current, charge, chemical species, and 
energy. The Battery Interfaces form the basis for battery cell and pack modeling.
The Chemical Species Transport ( ), the Fluid Flow ( ) and the Heat 
Transfer ( ) interfaces are extended with functionality for battery modeling, for 
instance features for handling porous media. The different physics interfaces are 
further discussed below.
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Battery Modeling

The Battery Design Module has a number of physics interfaces to model batteries. 
Choice of physics interface depends on the overall purpose of the model.

Detailed Cell Models
When studying the cell chemistry, aging, or high charge-discharge rates one 
typically resolves the different layers of the battery using space-dependent models 
on a micrometer scale, whereas coarser models for computing heat sources or 
predicting the voltage behavior for low or moderate charge-discharge rates may 
use a more lumped modeling approach.
Space-dependent battery models often model unit cells that consist of:
a) Current collectors and current feeders
b) Porous or solid metal electrodes
c) The electrolyte that separates the anode and cathode
To exemplify, we describe some of the charge and discharge processes in a 
rechargeable battery below.

Figure 2: Direction of the current and charge transfer current during discharge in a battery with porous 
electrodes.
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During discharge, chemical energy is transferred to electric energy in the charge 
transfer reactions at the anode and cathode. The conversion of chemical to electric 
energy during discharge may involve electrochemical reactions, transport of 
electric current, transport of ions and neutral species in the electrolyte, mass 
transport in the electrode particles, fluid flow, and the release of heat in irreversible 
losses, such as ohmic losses and losses due to activation energies.
Figure 2 shows a schematic picture of the discharge process. The current enters the 
cell from the current feeder at the negative electrode. The charge transfer reaction 
occurs at the interface between the electrode material and electrolyte contained in 
the porous electrode, also called the pore electrolyte. Here, an oxidation of the 
electrode material may take place through an anodic charge transfer reaction, 
denoted iloc, a in Figure 2. The shapes of the two curves in the graph are described 
by the electrode kinetics for the specific materials. The reaction may also involve 
the transport of chemical species from the pore electrolyte and also from the 
electrode particles.
From the pore electrolyte, the current is conducted by the transport of ions 
through the electrolyte that separates the positive and negative electrode (via 
separator or reservoir) to the pore electrolyte in the positive electrode.
At the interface between the pore electrolyte and the surface of the particles in the 
porous electrode, the charge transfer reaction transfers the electrolyte current to 
current conducted by electrons in the positive electrode. At this interface, a 
reduction of the electrode material takes place through a cathodic charge transfer 
reaction, denoted iloc, c in Figure 3. Also here, the charge transfer reaction may 
involve the transport of chemical species in the electrolyte and in the electrode 
particles.

Figure 3: Electrode polarization during discharge. The figure is same as inset of Figure 2.
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The current leaves the cell through the current collector. The conduction of 
current and the electrochemical charge transfer reactions also release heat due to 
ohmic losses, activation losses, and other irreversible processes.
The graph in Figure 3 plots the charge transfer current density, iloc, as a function 
of the electrode potential, E. These curves describe the polarization of the 
electrodes during discharge.
The negative electrode is polarized anodically during discharge, a positive current 
as indicated by the arrow in Figure 3. The potential of the negative electrode 
increases. The positive electrode is polarized cathodically, a negative current as 
indicated by the arrow. The potential of the positive electrode decreases.
Consequently, Figure 3 also shows that the potential difference between the 
electrodes, here denoted Ecell, decreases during discharge compared to the open 
cell voltage, here denoted Eocv. The value of Ecell is the cell voltage at a given 
current iloc, if the ohmic losses in the cell are negligible. This is usually not the case 
in most batteries. This implies that the cell voltage in most cases is slightly smaller 
than that shown in Figure 3.
During charge, the processes are reversed; see Figure 4. Electric energy is 
transformed to chemical energy that is stored in the battery.

Figure 4: During charge, the positive electrode acts as the anode while the negative one acts as the 
cathode. The cell voltage increases (at a given current) compared to the open cell voltage. Note: direction 
of the currents is reversed here.
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The current enters the cell at the positive electrode. Here, during charge, an 
oxidation of the products takes place through an anodic charge transfer reaction. 
The positive electrode is polarized anodically, with a positive current, and the 
electrode potential increases.
The current is then conducted via pore electrolyte, through the electrolyte in a 
separator (or a reservoir) that separates the electrodes, to the negative electrode.
In the negative electrode, a reduction of the products from the previous discharge 
reaction takes place through a cathodic charge transfer reaction. The negative 
electrode is polarized cathodically and the electrode potential decreases.

Figure 5: Electrode polarization during charge.

The difference in potential between the electrodes, here denoted Ecell, at a given 
iloc, increases during charge, compared to the open cell voltage, here denoted Eocv; 
see Figure 5. The value of Ecell is equal to the cell voltage when ohmic losses are 
neglected. In most cells, these losses are not negligible and they would add to the 
cell voltage.
The battery processes and phenomena described in the figures above can all be 
investigated using the Battery Design Module. The physics interfaces included in 
the module allow you to investigate the influence on battery performance and 
thermal management of parameters such as the:
• Choice of materials and chemistry
• Dimensions and geometry of the current collectors and feeders
• Dimension and geometry of the electrodes
• Size of the particles that the porous electrodes are made of
• Porosity and specific surface area of the porous electrode
• Configuration of the battery components
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• The kinetics of interfacial and bulk reactions
• Potential or applied current dependent load cycles
• Aging of electrochemical cells

Lumped Models
When modeling larger systems such as a battery pack, including detailed 
geometrical details of the individual battery layers, electrode structures and 
chemistry may not be practical from a modeling point of view. Many details about 
the battery cell may not be known to the modeler, and numerical constraints 
(memory and computational time) may favor less complex models. For these cases 
one often replaces the detailed cell model by simpler zero-dimensional cell 
elements, forming an equivalent circuit, lumped battery or single particle model. 
For instance, instead of a detailed mass and charge balance of charge-carrying ions 
in the electrolyte phase along the length of the negative electrode, the separator, 
and the positive electrode, all voltage contributions from these phenomena are 
lumped into a single resistor.
In a battery pack model a number of these zero-dimensional models for each 
battery cell are then combined to define the cell-to-cell current distribution of the 
pack.

The Battery Modeling Physics Interfaces
The Lithium-Ion Battery interface ( ) is tailored detailed modeling of 
lithium-ion batteries using liquid electrolytes and includes functionality that 
describes the transport of charged species in porous electrodes, electrolyte, 
intercalation reactions in electrodes, binders, charge transfer reactions, internal 
particle diffusion, temperature dependence of transport quantities, aging 
mechanism, and the solid electrolyte interface (SEI).
The Lithium-Ion Battery, Single-Ion Conductor interface ( ) is similar to the 
above interface, but uses a different default for charge-balance equation in the 
electrolyte, typically suitable for solid electrolytes.
The Battery with Binary Electrolyte interface ( ) describes the conduction of 
electric current in the electrodes, the charge transfer reactions in the porous 
electrodes, the mass transport of ions in the pore electrolyte and in the electrolyte 
that separates the electrodes, and the intercalation of species in the particles that 
form the porous electrodes. The descriptions are available for cells with basic 
aqueous binary electrolytes, which for instance covers nickel-metal hydride and 
nickel-cadmium batteries.
The Lumped Battery interface ( ) defines a battery model based on a small set 
of lumped parameters, requiring no knowledge of the internal structure or design 
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of the battery electrodes, or choice of materials. Models created with the Lumped 
Battery interface can typically be used to monitor the state-of-charge and the 
voltage response of a battery during a load cycle. The interface also defines a 
battery heat source that may be coupled to a Heat Transfer interface for modeling 
battery cooling and thermal management.
The Lumped Battery, Two Electrodes interface ( ) offers a slightly more 
advanced definition of the battery model where each electrode material is handled 
individually, but still in a lumped context. It accounts for solid diffusion in the 
electrode particles, the intercalation electrode reaction kinetics and ohmic 
potential drop in the separator using a lumped solution resistance term. Models 
defined in this way are also known as single-particle models in literature.
The Battery Equivalent Circuit ( ) can be used to define a battery model based 
on an arbitrary number of electrical circuit elements. Models created with the 
Battery Equivalent Circuit can typically be used to monitor the state-of-charge and 
the voltage response of a battery during a load cycle. When selecting the Battery 
Equivalent Circuit in the Model Wizard, this adds an Electrical Circuit ( ) 
interface to the model, including a number of predefined circuit elements that are 
used to define the open circuit voltage, the load current and an internal resistance. 
You can add additional circuit elements such as resistors, capacitors, and inductors.
The Lead-Acid Battery interface ( ) is tailored for this type of battery and 
includes functionality that describes the transport of charged species, charge 
transfer reactions, the variation of porosity due to charge and discharge, and the 
average superficial velocity of the electrolyte caused by the change in porosity.
The Battery Pack interface ( ) features a one-to-many approach for setting up 
multiple lumped battery models and for connecting them in a 3D geometry. The 
Battery Pack interface is typically used together with a heat transfer interface for 
modeling of thermal pack management. The interface also includes thermal 
events, which can be used to study thermal runaway propagation problems.
The current distribution interfaces are generic electrochemical cell interfaces. The 
Tertiary Current Distribution, Nernst-Planck interface ( ) describes the 
transport of charged species in diluted electrolytes through diffusion, migration, 
and convection. In addition, it also includes ready-made formulations for porous 
and nonporous electrodes, including charge transfer reactions and current 
conduction in the electronic conductors.
The Concentrated Electrolyte Transport interface ( ) is a generic interface for 
defining electrolyte transport. The electrolyte transport model is based on 
concentrated solution theory and can be applied to any type of electrochemical cell 
for an arbitrary number of electrolyte species, for instance cells based on 
molten-salt or ionic-liquid electrolytes. The Lithium-Ion, Battery with Binary 
Electrolyte and Lead-Acid interfaces mentioned above all make use of variants of 
12 | 



concentrated solution theory for specific ternary (anion/cation/solvent) 
electrolyte systems.
The Chemical Species Transport interfaces ( ) can be used to describe for 
instance the transport of trace ions in the pore electrolyte and in the electrolyte 
that separates the anode and cathode. Reactions other than pure electrochemical 
reactions can be added to, for example, describe the degradation of materials. 
The Chemistry interface ( ), found within the Chemical Species Transport 
branch, can be used to define systems of reacting species, electrode reactions and 
ordinary chemical reactions. As such, it serves as a reaction kinetics and material 
property provider to the space-dependent transport interfaces, such as the Tertiary 
Current Distribution, Nernst–Planck interface, or Transport of Diluted Species 
interface.
The Fluid Flow interfaces ( ) describe the fluid flow in the porous electrodes 
and in free media if this is relevant for a specific type of battery, for example, certain 
types of lead-acid batteries.
The Heat Transfer in Porous Media interface ( ) describes heat transfer in the 
cells. This includes the effects of Joule heating in the electrode material and in the 
electrolyte, heating due to activation losses in the electrochemical reactions, and 
of the net change of entropy. The heat from reactions other than the 
electrochemical reactions can also be described by these physics interfaces. The 
heat transfer interfaces are also extended with tailor-made functionality for 
homogenization of layered battery materials, which are typically used in thermal 
simulations of battery packs.
The Solid Mechanics interface ( ) is extended with functionality for modeling 
electrode strain due to, for instance, lithium intercalation in graphite electrodes.
 | 13



Physics Interface Guide by Space Dimension and Study 
Type

The table lists the physics interfaces available in the Battery Design Module in 
addition to those included with the COMSOL basic license. 

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE

 Chemical Species Transport

Transport of Diluted 
Species

tds all dimensions stationary; time dependent

Transport of Concentrated 
Species

tcs all dimensions stationary; time dependent

Chemistry chem all dimensions stationary; time dependent

Nernst–Planck–Poisson 
Equations

tds+es all dimensions stationary; time dependent; 
stationary source sweep; 
small-signal analysis, 
frequency domain

Electrophoretic Transport el all dimensions stationary; stationary with 
initialization; time 
dependent; time dependent 
with initialization

Transport of Diluted 
Species in Porous Media

tds all dimensions stationary; time dependent

Transport of Concentrated 
Species in Porous Media

tcs all dimensions stationary; time dependent

Surface Reactions sr all dimensions stationary (3D, 2D, and 2D 
axisymmetric models only); 
time dependent

Transport of Diluted 
Species in Fractures

dsf 3D, 2D, 2D 
axisymmetric

stationary; time dependent

 Reacting Flow

Laminar Flow, Diluted 
Species

— 3D, 2D, 2D 
axisymmetric

stationary; time dependent
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Laminar Flow, 
Concentrated Species

— 3D, 2D, 2D 
axisymmetric

stationary; time dependent

 Reacting Flow in Porous Media

Transport of Diluted 
Species

— 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Transport of 
Concentrated Species

— 3D, 2D, 2D 
axisymmetric

stationary; time dependent

 Nonisothermal Reacting Flow

Brinkman Equations — 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Laminar Flow — 3D, 2D, 2D 
axisymmetric

stationary; time dependent

 Electrochemistry

Primary Current 
Distribution

Secondary Current 
Distribution

cd all dimensions stationary; stationary with 
initialization; time 
dependent; time dependent 
with initialization; AC 
impedance, initial values; AC 
impedance, stationary; AC 
impedance, time dependent

Tertiary Current 
Distribution, Nernst–Planck 
(Electroneutrality, 
Water-Based with 
Electroneutrality, 
Supporting Electrolyte, 
Poisson)

tcd all dimensions stationary; stationary with 
initialization; time 
dependent; time dependent 
with initialization; AC 
impedance, initial values; AC 
impedance, stationary; AC 
impedance, time dependent

Concentrated Electrolyte 
Transport

cet all dimensions stationary; stationary with 
initialization; time 
dependent; time dependent 
with initialization;

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE
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Electroanalysis tcd all dimensions stationary; time dependent; 
AC impedance, initial values; 
AC impedance, stationary; 
AC impedance, time 
dependent; cyclic 
voltammetry

Electrode, Shell els 3D, 2D, 2D 
axisymmetric

stationary; time dependent

 Battery Interfaces

Lithium-Ion Battery

(Binary 1:1 Liquid 
Electrolyte,

Single-Ion Conductor)

liion all dimensions stationary; time dependent; 
AC impedance, initial values; 
AC impedance, stationary; 
AC impedance, time 
dependent

Battery with Binary 
Electrolyte

batbe all dimensions stationary; time dependent; 
AC impedance, initial values; 
AC impedance, stationary; 
AC impedance, time 
dependent

Lead–Acid Battery leadbat all dimensions stationary; time dependent; 
AC impedance, initial values; 
AC impedance, stationary; 
AC impedance, time 
dependent

Lumped Battery lb all dimensions time dependent; AC 
impedance, initial values;

Battery Equivalent 
Circuit

ec Not space 
dependent

stationary; time dependent; 
frequency domain

Battery Pack bp 3D time dependent

 Fluid Flow

 Porous Media and Subsurface Flow

Brinkman Equations br 3D, 2D, 2D 
axisymmetric

stationary; time dependent

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE
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Darcy’s Law dl all dimensions stationary; time dependent

Free and Porous Media 
Flow, Brinkman

fp 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Free and Porous Media 
Flow, Darcy

— 3D, 2D, 2D 
axisymmetric

stationary; time dependent

 Nonisothermal Flow

Brinkman Equations — 3D, 2D, 2D 
axisymmetric

stationary; time dependent; 
stationary, one-way NITF; 
time dependent, one-way 
NITF

 Heat Transfer

Heat Transfer in Porous 
Media

ht all dimensions stationary; time dependent

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE
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Tutorial of a Lithium-Ion Battery

The following tutorial defines a three-dimensional model of a lithium-ion battery 
pouch cell. In the pouch battery cell design, all current exits the cell on the cell 
“tabs”, and as the cell size and power increases, the voltage gradients in the highly 
conductive metal foil current collectors may come into play, resulting in a 
nonuniform current distribution and electrode utilization in the cell. A 
nonuniform utilization results in suboptimal use of the battery electrodes and may 
also result in nonuniform and accelerated electrode aging.
The aim of the tutorial is to get acquainted to the most common features in the 
Lithium-Ion Battery interface for battery modeling, and to investigate the current 
distribution and electrode utilization in a large format lithium-ion battery pouch 
cell.
(A more common, and computationally more favorable, approach for battery 
modeling is often to define the model geometry in 1D, and as we will see in this 
tutorial, this is often a valid approximation. Tutorials featuring more conventional 
geometries are available in the Battery Design Module Application Library.)
The model defines and solves the current and material balances in the lithium-ion 
battery. The intercalation of lithium inside the particles in the porous electrodes is 
solved using a fourth independent variable r for the particle radius (x, y, and t are 
the other three). The reaction kinetics and the intercalation are coupled to the 
material and current balances at the surface of the particles. The model equations 
are found in the Battery Design Module User’s Guide. The model was originally 
formulated for 1D simulations by John Newman and his coworkers at the 
University of California at Berkeley. The original 1D model is popularly known as 
pseudo-2D model (or P2D model) in literature, for our 3D case the 
corresponding popular name would be P4D. 
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Model Definition
The cell geometry is shown in the figure below. Note that all plots are scaled 100 
times in the z direction due to the high aspect ratio of the geometric features.

Model geometry, scaled 100 times in the z direction.

The geometry defines one foil-to-foil unit cell, stacking five layers in the z 
direction:
• Negative metal current collector foil: 10 mm, Cu (due to symmetry, half of 

this thickness is used in the model geometry)
• Negative electrode: 60 mm, graphite
• Separator: 30 mm
• Positive electrode: 60 mm, LMO
• Positive metal current collector foil: 10 mm, Al (due to symmetry, half of 

this thickness is used in the model geometry)

The electrolyte is LiPF6 dissolved in the organic solvents EC and EMC at a 3:7 
ratio.
Symmetry is assumed along the center of the cell.
The positive and negative current terminals are located opposite to each other (but 
may easily be placed on the same side by altering the Geometry node in the 
model).
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The Lithium-Ion Battery interface is used to set up the physics, using Material data 
from the Battery Material Library. After finishing the modeling instructions later 
the part of the model tree defining the materials and physics will look as below.

Figure 6: Part of the model tree defining the materials and physics.

The Particle Intercalation subnodes to the Porous Electrode nodes model the 
solid lithium concentration in an additional particle dimension (extra dimension). 
The SOC and Initial Cell Charge Distribution node is used to set the initial cell 
state of charge. 
An Electrode Ground boundary condition is used on the negative tab whereas an 
Electrode Current boundary condition defines the cell current exiting the cell on 
the positive tab. 
A time-dependent solver is used to simulate the charging from a 20% to 90% cell 
state of charge at a rate of 4 C. (A 1 C rate corresponds to the charge or discharge 
current required to fully charge or discharge the battery in 1 h).

RESULTS AND DISCUSSION

The figure below shows the simulated cell voltage vs time.
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Cell voltage vs time.

The two following figures show the potential distribution in the negative and 
positive metal foils (current collector and tab) at the end of the 4C charge. 

Potential distribution in the negative metal foil at the end of the 4C charge.
 | 21



Potential distribution in the positive metal foil at the end of the 4C charge.

The potential variation is about 5 mV in the negative current collector and 9 mV 
in the positive current collector at the 4C charge current. For a 1C charge current 
the corresponding potential variation would be below 2 mV (results not shown 
here).
The two figures below show the electrolyte current magnitude for a cross section 
in the middle of the separator at the beginning and end of the 4C charge, 
respectively. This provides a measure of the electrode utilization for a given time. 
The current distribution varies about 6% in the separator plane over time. For 1C, 
the variation would be generally smaller (results not shown here). Initially, the 
separator current density is higher close to the tabs whereas toward the end of the 
charge, the current density is higher in the central parts of the cell.
22 | 



Current density magnitude in the middle of the separator at the beginning of the 4C charge.

Current density magnitude in the middle of the separator at the end of the 4C charge.

The following instructions show how to formulate, solve, and reproduce this 
model.
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Model Wizard

1 To start the software, double-click the COMSOL Multiphysics icon on the 
desktop. When the software opens, you can choose to use the Model Wizard to 
create a new COMSOL Multiphysics model or Blank Model to create one 
manually. For this tutorial, click the Model Wizard button.
If COMSOL Multiphysics is already open, you can start the Model Wizard by 
selecting New  from the File menu and then click Model Wizard .

2 From the File menu, choose New.
3 In the New window, click Model Wizard.
4 In the Model Wizard window, click 3D.
5 In the Select Physics tree, select Electrochemistry > Batteries > 

Lithium-Ion Battery (liion) and click Add.

6 Click Study.
7 In the Select Study tree, select Preset Studies for Selected Physics Interfaces > 

Time Dependent with Initialization.
8 Click Done.
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Geometry 1

The model geometry is available as a parameterized geometry sequence in a 
separate MPH-file. Load it from file with the following steps.
1 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
pouch_cell_utilization_geom_sequence.mph. Note that the location of the 
files used in this exercise may vary depending on the installation. For example, 
if the installation is on your hard drive, the file path might be similar to C:\
Program Files\COMSOL\COMSOL63\Multiphysics\applications\

Battery_Design_Module\Lithium-Ion_Batteries,_Performance\.

3 In the Geometry toolbar, click Build All.
4 In the Model Builder window, under Component 1 click Geometry 1.
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5 Since the geometry has now been finalized, you may now collapse the 
Geometry 1 node in the Model Builder window.

Change the Scal ing of the Graphics Window

The cell geometry has a high aspect ratio, with the 
cell thicknesses being very small in relation to the 
cross-sectional area. To facilitate setting up the 
physics, change the scaling in the z direction as 
follows:

Camera
1 In the Model Builder window, expand the 

Component 1 > Definitions node, expand the 
View 1 node, then click Camera.

2 In the Settings window for Camera, locate the Camera section.
3 From the View scale list, choose Manual.
4 In the z scale text field, type 100.
5 Click Update.
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Global Definit ions

Parameters
Some parameters were loaded with the geometry 
sequence into the Parameters 1 node.
1 In the Model Builder window, under 

Global Definitions click Parameters 1.
2 In the Settings window for Parameters, type 

Geometry Parameters in the Label text field to 
rename it.

Add some more parameters from a text file.
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for the new Parameters 
node, type Physics Parameters in the Label text 
field.

3 Locate the Parameters section. Click 
Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file 
pouch_cell_utilization_physics_parameters.txt.

Add Materials

Most of the required material parameters are available in the material libraries. 
First add Copper and Aluminum for the current conductors.

1 In the Materials toolbar, click Add Material to open the Add Material 
window.
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2 Go to the Add Material window.
3 In the tree, select both Built-in > Aluminum 

and Built-in > Copper.
4 Click the Add to Component button in the 

window toolbar.

Next add the material properties for the electrolyte and electrode materials.
1 Go to the Add Material 

window.
2 In the tree, select both 

Battery > Electrodes > 
Graphite, LixC6 MCMB (N
egative, Li-ion Battery) and 
Battery > Electrodes > 
LMO, LiMn2O4 Spinel (Po
sitive, Li-ion Battery).

3 Click the 
Add to Component button 
in the window toolbar.

4 Similarly, in the tree, select Battery > Electrolytes > 
LiPF6 in 3:7 EC:EMC (Liquid, Li-ion Battery) and click the 
Add to Component button in the window toolbar.

5 In the Materials toolbar, click Add Material to close the Add Material 
window.

A red cross may show at the Aluminum node at this point, indicating missing 
material properties.This is expected and will be fixed later when setting up the 
physics. Also, no selection warnings may be seen at the other material nodes.
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Assign the Materials to the Domains of the Geometry

Assign the materials to the corresponding battery domains.
1 In the Model Builder window, click 

Aluminum. 

2 In the Settings window for 
the Materials>Aluminum 
node, locate the 
Geometric Entity 
Selection section.

3 From the Selection list, 
choose 
Positive Current Collector 
and Tab.

The named selections that 
appear in the list are created 
under the Geometry node, 
and were automatically 
included in the geometry 
sequence file you imported 
earlier. 
Proceed similarly for the other materials:
1 Click Copper, and in the corresponding Geometric Entity Selection section, 

choose Negative Current Collector and Tab.
2 Click Graphite, LixC6 MCMB (Negative, Li-ion Battery) and choose 

Negative Electrode.
3 Click LMO, LiMn2O4 Spinel (Positive, Li-ion Battery) and choose 

Positive Electrode.
4 Click LiPF6 in 3:7 EC:EMC (Liquid, Li-ion Battery) and choose Separator.
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Lithium-Ion Battery

The geometry has now been defined, and we have 
imported the needed parameters. We are now ready 
to start defining the actual physics of the problem.
The Separator node was added to the interface by 
default. 

Add and Define the Negative Electrode
Keep the default settings for the Separator, and 
proceed to add and set up the physics in the porous 
electrodes and current collectors.
1 In the Physics toolbar, click Domains and 

choose Porous Electrode.
2 In the Settings window for Porous Electrode, 

type Porous Electrode - Negative in the Label 
text field.

3 Locate the Domain Selection section. From the Selection list, choose 
Negative Electrode.

4 Locate the Electrolyte Properties section. 
From the Electrolyte material list, choose 
LiPF6 in 3:7 EC:EMC (Liquid, Li-ion B
attery) .

5 Locate the Electrode Properties section. 
In the s text field, type sigmas_neg.

6 Locate the Porous Matrix Properties 
section. In the s text field, type epss_neg.

7 In the l text field, type 1-epss_neg.
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Particle Intercalation 1
1 In the Model Builder window, click 

Particle Intercalation 1.
2 In the Settings window for 

Particle Intercalation, locate the 
Particle Transport Properties section.

3 In the rp text field, type rp_neg.

Leave the settings of the Species Settings section 
as is for now. The initial species concentration 
setting will be made inactive later when we 
define the cell state of charge on a different 
node.

Porous Electrode Reaction 1
1 In the Model Builder window, click Porous Electrode Reaction 1.
2 In the Settings window for Porous Electrode Reaction, locate the 

Electrode Kinetics section.
3 In the i0,ref(T) text field, type i0ref_neg.

Add and Define the Positive Electrode
Proceed similarly to define the positive electrode.
1 In the Physics toolbar, click Domains and 

choose Porous Electrode and rename the node 
by typing Porous Electrode - Positive in the 
Label text field.

2 Locate the Domain Selection section. From the 
Selection list, choose Positive Electrode.

3 Locate the Electrolyte Properties section. From 
the Electrolyte material list, choose 
LiPF6 in 3:7 EC:EMC (Liquid, Li-ion Battery.

4 Locate the Electrode Properties section. In the 
s text field, type sigmas_pos.

5 Locate the Porous Matrix Properties section. In the s text field, type epss_pos.
6 In the l text field, type 1-epss_pos.

Particle Intercalation 1
1 Click Particle Intercalation 1 child node and in the 

Particle Transport Properties section, in the rp text field, type rp_pos.
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Porous Electrode Reaction 1
1 Click Porous Electrode Reaction 1 and in the Electrode Kinetics section, type 

i0ref_pos.

Current Conductor 1
1 In the Physics toolbar, click Domains and 

choose Current Conductor.
2 In the Settings window for Current Conductor, 

locate the Domain Selection section.
3 From the Selection list, choose 

Metal Foil Domains.

Electric Ground 1
1 In the Physics toolbar, click Boundaries and 

choose Electric Ground.
2 In the Settings window for Electric Ground, 

locate the Boundary Selection section.
3 From the Selection list, choose 

Negative Tab End.
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Enable SOC and Initial Charge Distribution
1 Enable the Define cell state of charge (SOC) and initial charge inventory on the 

Lithium-Ion Battery interface top node. This will allow us to set the initial SOC 
of the battery cell.

Then set the initial state of charge of the cell as follows:
2 In the Model Builder window, click 

SOC and Initial Charge Distribution 1.
3 In the Settings window for 

SOC and Initial Charge Distribution, 
locate the 
Initial Cell Charge Distribution section.

4 In the SOC0 text field, type SOC_start.

Set the Electrode Domain Selections
1 In the Model Builder window, click 

Negative Electrode Domain Selection 1.
34 | 



2 In the Settings window for Negative Electrode Domain Selection, locate the 
Domain Selection section. From the Selection list, choose Negative Electrode.
Proceed similarly for the positive selection:

3 Click Positive Electrode Domain Selection 1, choose Positive Electrode.

Electrode Current 1
Enabling the SOC and Initial Charge 
Distribution node means that the capacity of 
the cell can be defined. Add the final current 
boundary condition current based on a 
C-rate multiple as follows:
1 In the Physics toolbar, click 

Boundaries and choose 
Electrode Current.

2 In the Settings window for 
Electrode Current, locate the 
Boundary Selection section.

3 From the Selection list, choose Positive Tab End.
4 Locate the Electrode Current section. From the list, choose C-rate multiple.
5 In the Crate text field, type C_rate.

Mesh 1

Set up the mesh for the model. Use a mapped mesh on the top boundaries, and a 
swept mesh for remaining of the geometry.

Add a Mapped on the Topmost Boundary
1 In the Mesh toolbar, click More Generators and choose Mapped.
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2 Select Boundary 20 only. (This is the topmost boundary of the geometry.)
3 Click Build Mesh.

Add a Swept Mesh
1 In the Mesh toolbar, click Swept.

Distribution of Mesh Elements in the Negative Electrode
1 Right-click Swept 1 and choose Distribution.

By the use of Distribution nodes you can control the resolution in the z 
direction of the individual layers of the cell.

2 In the Settings window for Distribution, locate the Domain Selection section.
3 From the Selection list, choose Negative Electrode.
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4 Locate the Distribution section. From the Distribution type list, choose 
Predefined.

5 In the Number of elements text field, type 15.
6 In the Element ratio text field, type 3.

Proceed similarly for the other domains, with different number of element and 
ratio settings as follows:

Distribution of Mesh Elements in the Separator
1 In the Model Builder window, right-click Swept 1 and choose Distribution.
2 In the Settings window for Distribution, locate the Domain Selection section.
3 From the Selection list, choose Separator.
4 Locate the Distribution section. In the Number of elements text field, type 4. 

Keep the other default settings.

Distribution of Mesh Elements in the Positive Electrode
1 Right-click Swept 1 and choose Distribution.
2 In the Settings window for Distribution, locate the 

Domain Selection section.
3 From the Selection list, choose Positive Electrode.
4 Locate the Distribution section. From the 

Distribution type list, choose Predefined.
5 In the Number of elements text field, type 15.
6 In the Element ratio text field, type 3.
7 Select the Reverse direction checkbox.
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8 Click Build Mesh.
The finalized mesh should now look as follows.

Definit ions

Before solving, add also a probe for an automatically defined voltage variable 
created by the Electrode Current condition at the positive tab. Since the negative 
tab is grounded, this voltage corresponds to the cell voltage. The probe will store 
the cell voltage for every time step taken by the solver in a table, and a dynamically 
updated plot of the cell voltage will also be available while solving.

Cell Voltage Probe
1 In the Definitions toolbar, click Probes and 

choose Global Variable Probe.
2 In the Settings window for Global Variable Probe, 

type Cell Voltage Probe in the Label text field.
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3 Click Replace Expression in the upper-right corner of the Expression section. 
From the menu, choose Component 1 (comp1) > Lithium-Ion Battery > 
liion.phis0_ec1 - Electric potential on boundary - V.

4 Select the Description checkbox. In the associated text field, type Cell Voltage.

Study 1

The physics is now fully defined and ready for solving. Change the output times 
based on the sim_time parameter to store the solution at the beginning of, half 
way into, and at the end of the charge as follows:
1 In the Model Builder window, click 

Step 2: Time Dependent.
2 In the Settings window for 

Time Dependent, locate the 
Study Settings section.

3 In the Output times text field, type 0 sim_time/2 sim_time.
4 In the Study toolbar, click Compute.

The model takes approximately 2-3 minutes to solve.

Results

A plot of the battery voltage versus time is created automatically by the probe you 
added earlier.
 | 39



Rename the Default Probe Plot
1 In the Model Builder window, 

under Results click 
Probe Plot Group 1.

2 In the Settings window for 
1D Plot Group, type Cell 
Voltage Probe Plot in the 
Label text field.

3 In the Cell Voltage Probe Plot 
toolbar, click Plot.

Add a Plot Group for the Potential in Negative Current Collector and Tab
The following steps create a plot of the potential at the negative current collector 
and tab.
1 In the Results toolbar, click 3D Plot Group to create a new plot group.
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2 In the Settings window for 
3D Plot Group, type 
Potential in Negative 

Current Collector and Tab 
in the Label text field.

3 Click to expand the 
Selection section. Select 
Domain as Geometric entity 
level and thereafter Negative 
Current Collector and Tab 
as Selection.

4 Locate the Color Legend 
section. Select the 
Show maximum and minim
um values checkbox.

5 Click to expand the 
Number Format section. 
Select the 
Manual color legend setting
s checkbox.

6 In the Precision text field, 
type 4.
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Add Volume Plot to Plot the Potential
1 Right-click 

Potential in Negative Current Collector
and Tab and choose Volume.

2 In the Settings window for Volume, 
locate the Expression section.

3 Click Replace Expression in the upper-right corner of the Expression section. 
From the menu, choose Component 1 (comp1) > Lithium-Ion Battery > 
phis - Electric potential - V.

4 In the Potential in Negative Current Collector and Tab toolbar, click Plot.

Potential in Positive Current Collector and Tab
Duplicate the plot and modify the copy in order to view the potential at the 
positive current collector and tab.
1 In the Model Builder window, right-click 

Potential in Negative Current Collector and Tab and choose Duplicate.
2 In the Settings window for 3D Plot Group, type Potential in Positive 

Current Collector and Tab in the Label text field.
3 In the Model Builder window, expand the 

Potential in Positive Current Collector and Tab node.
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4 Locate the Selection section. Select Positive Current Collector and Tab as 
Selection and click Plot.

Current Density Across Separator at t=0 s
Plot the relative current density across the separator using a slice plot.
1 In the Results toolbar, click 3D Plot Group.
2 In the Settings window for 3D Plot Group, type Current Density Across 

Separator in the Label text field.
3 From the Time (s) list, choose 0.
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Slice 1
1 Right-click 

Current Density Across Separa
tor and choose Slice.

2 In the Settings window for 
Slice, click Replace Expression 
in the upper-right corner of the 
Expression section. From the 
menu, choose 
Component 1 (comp1) > 
Lithium-Ion Battery > 
liion.IlMag - Electrolyte curre
nt density magnitude - A/m².

3 Locate the Plane Data section. 
From the Plane list, choose 
XY-planes.

4 From the Entry method list, choose Coordinates.
5 In the Z-coordinates text field, type L_neg_cc/2+L_neg+L_sep/2.
6 In the Current Density Across Separator toolbar, click Plot.

Current Density Across Separator at t=630 s
1 In the Model Builder window, click Current Density Across Separator.
2 In the Settings window for 3D Plot Group, locate the Data section.
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3 From the Time (s) list, choose 630.
4 In the Current Density Across Separator toolbar, click Plot.

Additional instructions for how to plot integrated measures of the electrode 
utilization over the whole charge cycles, using general projection operators, can 
be found toward the end of the modeling instructions for the Electrode 
Utilization in a Large-Format Lithium-Ion Battery Pouch Cell tutorial found 
in the Battery Design Application Library. There you also find a number of 
other tutorials covering a multitude of cell chemistries and application areas.
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